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1 Introduction 

 

SKySMS is a unified communications* enterprise SMS-tool developed by SKyPRO. Using the 

SKySMS client, SMS text messages can be edited and sent/received directly from/to your 

GroupWise, Gmail or Exchange environments. 

 

When creating a new text message the recipient can be entered manually or be chosen from 

your GroupWise/Gmail/Exchange address book. You can send SMS messages to multiple 

recipients at the same time, just the same way as you do with emails. SKySMS uses your 

existing contact data and saves all SMS information to your GroupWise/Gmail/Exchange 

mailbox. 

SKySMS client is easy to install and allows the administrator to configure and manage all users, 

who are allowed to send text messages directly from their GroupWise/Gmail/Exchange 

mailboxes. 

A default connection to the SKyPRO SMS Gateway ensures that text messages are sent 

immediately at cost-effective rates. 

 

 

* Unified communications represents a concept where multiple modes of business communications can 

be seamlessly integrated. Unified communications integrates all the systems that a user might already be 

using and helps those systems work together in a real time. They combine multiple IT capabilities, 

enabling an efficient approach to communicating that change how individuals, groups and organizations 

conduct business — and provide key business benefits. 
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2 Requirements 

 

Hardware 

 

•   Processor: from Pentium III or Athlon minimum 500MHz 

•   Random access memory: minimum 512MB RAM 

•   Hard drive: Minimum 50 MB free disk space 

•   Graphics card: SVGA with a resolution of at least 1024x768 

 

Software 

 

Operating system: 

 

•   Microsoft Windows Vista 

•   Microsoft Windows 7 

•   Microsoft Windows 8 

•   Microsoft Windows 10 

 

Applications software: 

 

•   Novell GroupWise Client from Version 8.0 and higher (in case of using GroupWise), Gmail, 

Exchange or any IMAP4/SMTP compatible mail system 
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3 Features  
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4 Installation 

 

To install the SKySMS Client do the 

following steps:  

(Important: close all running programs 

before starting the installation.) 

 

Start the SSC_xxx_ins.exe file 

(SSC – SKySMS Client, xxx – version 

number), select language and click OK 

to continue.  

 

 

To continue SKySMS installation, accept 

the terms of the End-User License 

Agreement. Click Next to continue. 

 

 

 

Choose the destination folder and click 

Next to continue. 
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Choose the option Create a desktop 

shortcut and click Next to continue. 

 

 

Click Install to complete the SKySMS 

Client installation on your PC / laptop. 

 

 

 

The installation is successfully 

completed, please click Finish 
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4.1 Installation from the command line 

You can install the SKySMS Client from the command line with definite parameters. You can set 

all parameters values for the current user and for all the users on the PC at the same time. To 

install the SKySMS Client from the command line please use the following format: 

SMS_CL_x.x.x.x_ins.exe [/PARAM=VALUE [/PARAM=VALUE [...]]] 

The /PARAM can be the following: 

- /DIALPLANFILE - dial plan configuration xml file. If you have a dial plan configuration available 

and want to share it with other users, please use this parameter. Note, that xml file should be in 

the same folder, as an installation exe-file (e.g. DIALPLANFILE=dialplan.xml); 

- /SERVEREMAIL – SKySMS Server’s e-mail address (e.g. 

SERVEREMAIL=serveremail@mydomain.com); 

- /LANGUAGE – Language that you may use for the SKySMS Client configuration: English - en, 

German - de or French - fr (e.g.. LANGUAGE=en); 

- /PROXYENABLE – Enable/disable proxy. If value is TRUE, the parameter will be valid, if there 

is any other value, the parameter will be ignored (PROXYENABLE=TRUE); 

- /PROXYDOMAIN - Proxy domain/host. It makes sense if PROXYENABLE=TRUE 

(PROXYDOMAIN=192.168.1.1);  

- /PROXYPORT - Proxy port. It makes sense if PROXYENABLE=TRUE (PROXYPORT=8080); 

- /FORALLUSERS - If this parameter is set to TRUE, all the specified settings will be applied to 

all users on the definite PC. If value is TRUE, the parameter will be valid, if there is any other 

value, the parameter will be ignored (FORALLUSERS=TRUE). 

The additional command line parameters for the installer: 

- /VERYSILENT /SUPPRESSMSGBOXES /SP /NORESTART – all these parameters should be 

used together for a very silent automatic installation (e.g. via Zen Works); 

- /cleansettings – remove previous configuration settings. 

 

Example to install the SKySMS Client via the administration systems (e.g. Novell ZenWorks): 

SMS_CL_1.0.3.8_ins.exe /VERYSILENT /SUPPRESSMSGBOXES /SP /NORESTART 

/PROXYENABLE=TRUE /PROXYDOMAIN=192.168.1.1 /PROXYPORT=8080 
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5 Client Overview 

The main Client window has input fields for text of the SMS, the recipient’s number and other 

functions.  

More detailed description of the functions please read below. 

 

 

 

 

 

  



10 
 

6 Integration with GroupWise 

The SKySMS Client has a full integration with GroupWise. It allows the creation, addressing and 

sending of SMS messages from your GroupWise desktop as well as answering emails with 

SMS text messages. You can access the SKySMS Client directly from the GroupWise panel. 

When SMS is sent you will receive a report about its status to your mailbox. To get the details of 

SMS you can open the Discussion Thread in your report. 

 

 

You can send SMS text messages directly from your GroupWise mailbox, if your SKySMS 

Client settings are set up accordingly (see p.17). Right click the contact to send SMS and 

choose the necessary number. 
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7 Menu Toolbar 

 

Menu toolbar includes the main 

functional buttons. To receive delivery 

reports as well as journal directly to your 

GroupWise/Gmail/Exchange tick the 

checkbox Delivery report under the To 

field. 
The description of the buttons is 

given below. 

 

 

 

– sends SMS to the recipients right away 

 

– cancels everything and closes the SKySMS Client 

 

– opens the phones selector window 

 

– opens the settings window 

 

– you can monitor the history of all your messages and request the 

journal to your mailbox 

 
– you can request the discussion thread for the particular phone number. 

You will receive (to your mailbox) all messages that you sent to or 

received from this phone number. 

 

To get the reports about the status of your SMS text messages, please select the following 

options: 

Delivery report: monitor the status of your message(s) and receive a 

report (for each SMS text message separately) to your 

GroupWise/Gmail/Exchange mailbox. 

 

 

Auto journal: Get reports about the status of your
Bulk SMS text 

messages to your mailbox.
The Auto journal is used to escape the 
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mailbox being over spammed by the status messages. E.g. If you 

send an SMS to 5 recipients, you will be notified about the status of 

each outgoing SMS separately. If you activate Auto Journal for these 

messages, you will get all delivery reports in one journal message. 

 

Bulk SMS: Bulk SMS allows you to send an SMS to multiple 

recipients. 
You can choose contacts from your address books or 

the groups that you created in the SKySMS Client, from CSV files 

and /or manually enter recipients’ phone numbers. Using Bulk SMS 

you receive an auto journal with all delivery reports of your SMS 

message. 
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8 Main menu Items 

 

File menu item allows you to 

save your SMS messages as 

text, load text templates from 

your PC, save your message as 

a template as well as print your 

message or close the window. 

 

 

 

To load templates from your PC choose 

them in the folder they are located in and 

click Open: 

 

 

 

To save a message as a template or as a 

text choose a destination folder and a 

format, and click Save. 
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To print your SMS please click Print and 

choose the necessary printer, a number of 

pages/copies. 

Set the properties for the printer directly from 

your SKySMS Client.  

Click OK. 

 

 

 

In Contacts menu you can open your 

address books (phone numbers), edit 

your groups, import/export CSV files with 

contacts. 

 

 

Address books menu item and Address 

books button open the phone numbers 

selector window. 
Choose the necessary 

phone number from your existing address 

books for sending SMS by double clicking or 

with the arrow button. You can search your 

phone numbers by name, department or e-

mail address. Choose as many contacts as 

you need to send a bulk SMS message to. 
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If a contact has more than one phone number 

you should select one, while using the 

specially designed phone selector. Mark the 

number you need and click OK. 

 

 

 

Use Groups editor function for 

sending bulk SMS. Create local 

groups that you can use later for 

sending SMS to multiple recipients in 

advance. This way you will be able to 

send SMS to the whole group. 

 

 

Click the New button to create a 

group. All groups you create will be 

saved to the list of your address 

books by default. 

 

 

 

 

 

You can also type in contacts manually. 

If the contact already exists in your 

address book, it will be found 

automatically by its first letters. To 

activate the automatic name completion, 

go to Settings -> Address book for 

contact search and choose the address 

books you want to be used. 
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Import/Export of CSV files 

 

CSV stands for Comma Separated / 

Comma Delimited Values. 

A CSV file is a specially formatted 

plain text file which stores spreadsheet 

or basic database-style information in 

a very simple format, with one record 

on each line, and each field within that 

record separated by a comma. 

 

You can either save contacts you use 

for sending SMS to a CSV file or 

import a list of recipients from your 

CSV file.  

 

 

In Tools menu you can set up the 

necessary settings and dial rules for your 

SKySMS client (read more about dial 

rules on p. 17).  

Fill in the settings first for proper work of 

SKySMS Client. 
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Settings menu item: 

 

Server e-mail address: we recommend you 

to create a separate account (e-mail 

address) for SKySMS system to be used as 

a transport layer between the server and the 

clients. Please, enter the login and password 

you created for this account in e-mail tab.  

Language (English, German, French);  

Connection type (email platform that will be 

used for integration with SKySMS Client): 

please select the provider: 

 GroupWise 

If you choose GroupWise as a 

provider you do not need to enter any 

additional settings. The SKySMS 

Client will be working with the 

GroupWise account that is currently 

logged into the GroupWise Client. 

 Gmail  

Click the button Sign in to Google 

Services. 

 SMTP  

Fill in: login, password, domain and 

port number. 

 Exchange  

Fill in: login, password and URL. 

Also you can setup proxy if necessary. 

Address book for contacts search. Mark the 

necessary address books which will be used 

for the automatic name completion. Click 

Save. 

 

 

 

 

 

Dial Plan* Configuration: is an optimal system that should be used to create dial rules if some 

of the numbers in your address books do not contain country/area/mobile provider`s codes and 

do not comply with the international standard that we use in our solution. In this case we use the 
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dial plan configuration based on the principle of regular expressions within the patterns (pattern 

match method). Due to this method the patterns that correspond to several numbers could be 

created in the dial plan configuration. 

There is the following syntax for regular expressions: 

 

x – for any digital character from 0 to 9 

z – for any digital character from 1 to 9 

n – for any digital character from 2 to 9 

. (dot) – for any character or set of digital characters 

Here are a couple of examples of possible patterns to use: 

 

 “0z.” – this pattern corresponds to any number, with 0 in the first position “0”, any 

character from 1 to 9 in the second position “z”, and the character from 0 to 9 or the set 

of characters “.” (e.g.: 078 1234567, 01234 1234567, 0123 1234567). This pattern is 

convenient to use if the numbers in the address books are written without country code 

and both mobile provider`s code and the number itself consist of different amount of 

symbols. 

 “0zxxxxxxxx” – this pattern corresponds to the phone number that has “0” in the first 

position, the second position matches any character from 1 to 9 (“z”) and the last 

position consists of 8 numbers from 0 to 9 (e.g. 050 1234567, 096 2841385, 079 

1234567). This pattern will apply only to the numbers with the definite amount of 

characters. 

 “zx0z.” or “zx0zxxxxxxxx” or “zx0zxxxxxxxxx” – these patterns are used for the 

numbers, which have 0 between the two-digit country code and the mobile provider`s 

code, with any amount of characters after 0 (zx0z.) or with the defined amount of 

characters zx0zxxxxxxxx (e.g. 49012341234567, 410121234567).  

 

If the phone numbers in your address book have no country/area code or do not comply with the 

required standards of dialing you can create a chain of dial rules, using the above described or 

other patterns. 

 

There are the following types of the rules: 

 

1) “Delete” is used for deleting of definite amount of characters, starting from the chosen 

position. 
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2) “Prefix” is used for adding the definite numerical value or symbol into the first position 

(always before the number). E.g. to add the country code with “+” symbol before the 

number. 

3) “Insert” is used for the adding of any character/set of characters into the chosen position. 

4) “Replace” is used to replace the chosen set of symbols with another set (e.g. to replace the 

country code of one country to another): e.g. +41781234567, where you replace +41 with 

+33 to get +33781234567 for another country. Please note: the given combination will be 

replaced for the whole number but not just for the first adjustment. 

Dial rule examples 

As your address books may contain numbers in various formats (e.g. 0781234567, 

0041781234567, 41(0)781234567, +41(0)781234567 or (+) 41781234567 (in international 

format), we would like to give you some detailed examples of the dial rules configuration. 

Please note, in these examples we use numbers with two-digit country codes (Germany – 49, 

Switzerland – 41, Austria – 43). The numbers with the three-digit (Zimbabwe – 263, Bulgaria – 

359, Finland - 358) or single-digit (Russia – 7, USA - 1) country codes, or country codes that 

contain 0 (Czech Republic – 420, Ukraine – 380, Lithuania - 370) do not match the rules used in 

our examples.  

 

Here is a chain of rules for the transformation of the numbers described above, using SKySMS 

Client=> Tools => Dial plan configuration => Add new rule: 

The 1st rule will process the number that was 

already entered in the international format 

(e.g. 41781234567). To apply the rule please 

set the pattern “zxz.” and choose the rule 

“Delete”.  

 

Please delete zero (0) symbol from the first (1) 

position in the telephone number. Put the rule 

to the 1st position in the rule list and make it 

final. 

  

This rule is formal, it does not transform the number itself. This rule has to be set as “final” for 

the phone number, which is already written in international format. In this way we exclude the 

use of other patterns that also correspond to this number and can imply phone number 

transformation. 
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Note, that 0 cannot be presented in the third position. The number written in the international 

standard with the country code containing 0 (370 123 1234567) will not match this pattern. 

 

The 2nd rule transforms the phone numbers, 

which contain “0” after the country code before 

the mobile provider`s code (e.g. 41 0 

791234567). We will use the pattern “zx0.” for 

this number. We choose the rule “Delete”. In 

this way we delete 0 from the 3rd position (1 

symbol from the third position). Put the rule to 

the 2nd position in the rule list and make it final. 

 

 

Please note, this pattern matches the phone numbers that contain 0 in the third-digit country 

code on the third position (420 123 1234567). But in this case 0 should not be deleted. 

The 3rd rule is for the numbers which contain 

“+” before the country code and “0” before the 

mobile provider’s code (+ 49(0)781234567). 

Here we will use the pattern “+zx0.” Choose 

“Delete” rule to delete 1 symbol (0) from the 4th 

position. Set the rule to the 3rd position in the 

list and make it final. 

 

 

Please note that this rule may also apply to the numbers that have “0” within the country code 

itself (+420 123 1234567). In this case “0” should not be deleted.  

Now we will transform the phone number that starts with “0” before the mobile provider`s code 

(e.g. 0791234567). For this transformation we should create the chain of two rules. 
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Set the pattern “0z.” and choose the rule 

“Delete”. We delete one of the symbols from 

the 1st position. In this way we delete 0 before 

the mobile provider`s code. Put the rule to the 

4th position in the general rules list. 

 

 

 

 

After the transformation the number was 

changed and started to correspond to the 

pattern “z.” so we should apply it in the field 

Pattern. Choose the rule “Prefix”, put “41” and 

put this rule to the 5th position in the general 

rules list. Make it final. 

 

 

 

With this rule we add a country code for the 

number. It is possible to create other similar 

rules for different countries. 

But the rules of this type cannot be activated 

at the same time. 
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Now we will create a rule for the numbers with 

“00” at the beginning. We need to use “00z.” 

pattern and choose the rule “Delete”. In this 

case we delete two symbols (00) from the 1st 

position. For this rule we set the 6th position in 

the general rules list and make it final. 

 

 

 

Pay attention: 

 

- It is also possible to set a definite amount of digits in the pattern, e.g. zx0xxxxxxxxx. If the 

number contains more digits and it is set in the pattern, the number will not be transformed 

by this pattern and the system will search for the correspondence with the other patterns. 

 

- For the transformation of one phone number you may require a chain of rules but not only 

one rule. 

 

- The number can correspond to several patterns. That is why the transformation can be 

incorrect. Therefor you should use the rules order in the general rule list. 

 

- The rule marked as “final” will stop the number transformation and system will not search for 

the conformity with the other patterns in the rule list. 

 

- Please set “make the rule final” option only where it is necessary. This option will let you 

finish the number transformation. 

 

The following rules are not universal, but allow unifying of the dialing process or choosing a 

number from the address books. 
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In the Help menu you will find some 

useful documents about SKySMS: 

 SKySMS Client main window 

overview ,  

  SMS Client manual,  

 A link to the complete list of the 

available SKySMS documents. 

 

To see what version of the SKySMS 

Client you are currently using, click 

About. 
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9 Email2SMS Gateway 

 

Email2SMS Gateway allows you to send SMS messages in the form of emails (without the 

SKySMS Client). These emails should be created due to the following rules: 

 

1. Click New Email in your email client and enter the email address of your SKySMS Server in 

the field To (the same email address as configured on the SKySMS Server in the tab E-mail). 

2. In the field Subject enter [sms] 

3. In the email Body write a text of your SMS. 

4. Enter any of the special command tags you need in the email Body. Use the following format: 

@@Tag [Value1[; Value2[;...ValueN]]]@@ 

4.1 To enter a recipient's phone number use the tag @@recipients@@ or @@rc@@. Several 

numbers have to be separated by comma or semicolon. E.g: 

 @@rc 380662037171; 380765432109@@ 

 

4.2 To receive a delivery report use the tag @@Delivery@@ or @@dn@@ without values. 

4.3 If you do not want to use the whole Body text as SMS text, you can use the tag 

@@Text@@ or @@tx@@. E.g.: 

@@tx The text for the SMS@@ 

4.4 If you want to use the email Subject as SMS text (in this case the string [sms] will be 

excluded from SMS text), you can use the tag @@SubjectAsText@@ or @@sbj@@ without 

values. 
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5. After sending an email you will get the delivery information to your mailbox with the GUID 

number assigned by the SKySMS Server to this email. This GUID number you can use in order 

to get the delivery status of the sent SMS: 

 

1) send another email to the SKySMS Server email address with the subject [sms] 

2) in the body of the email enter: 

 

@@Journal guid_number@@ or @@jr guid_number@@ 

E.g.: @@jr {0DAE3038-79EE-4BBD-A1A4-A3607B2A7258}@@ 

 

Afterwards you will receive a new email with the current status of your SMS. 

Pay attention: 

Only users which email addresses are added to the user list on the SKySMS Server are allowed 

to send SMS message. It concerns the SMS sending using the SKySMS Client and via 

Email2SMS Gateway. 

 

6. You can request the Discussion Thread for the particular phone number: 

 1) Send another email to the SKySMS Server email address with the subject [sms] 

 2) In the email body use the following tags: 

  - @@DiscussionThreadRequest phone numbers@@ or @@dtr phone numbers@@ - 

to enter a phone number for the discussion thread. Several phone numbers have to be 

separated by comma or semicolon. E.g.: @@dtr 380662037171; 380765432109@@ 
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  - @@FromDate@@ or @@fd@@ - to enter a start date of the discussion thread 

period. The date format is y-m-d. If it is not set up then the start date will be the beginning of the 

SKySMS Server’s  work. E.g: @@fd 2014-06-15@@ 

  - @@ToDate@@ or @@td@@ - to enter an end date of the discussion thread period. 

The date format is y-m-d. If it is not set up then the end date will be now. E.g.: @@td 2016-11-

15@@ 

 

As a result you will receive a new email with the requested discussion thread. 

 

 

 

 

 

 Should you have any questions or need further assistance, do not hesitate to contact 

SKyPRO support at any time. Besides writing an email to swsupport@skypro.ch you can 

contact us 24/7 in the live chat following the next link: http://skypro.eu/support.aspx 

 

Thank you for your choice. 

SKyPRO Team  

mailto:swsupport@skypro.ch
http://skypro.eu/support.aspx

